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The Digital Viking 
 The Digital Viking is the official monthly publication of 
the Twin Cities PC User Group, a 501(c)(3)organization and an 
all-volunteer organization dedicated to users of IBM-compatible 
computers. Subscriptions are included in membership. We wel-
come articles and reviews from members. The Digital Viking is a 
copyrighted publication and reproduction of any material is 
expressly prohibited without permission. Exception: other User 
Groups may use material if unaltered and credited. 
 Disclaimer: All opinions are those of the authors and do 
not necessarily represent the opinions of the TC/PC, its Board of 
Directors, Officers, or newsletter staff. TC/PC does not endorse, 
rate, or otherwise officially comment on products available; 
therefore, readers are cautioned to rely on the opinions presented 
herein exclusively at their own risk. The Digital Viking, its 
contributors, and staff assume no liability for damages arising out 
of the publication or non-publication of any advertisement, 
article, or other item. All refunds in full or in partial, for advertis-
ing, membership or any other item shall be at the sole discretion 
of the Twin Cities PC User Group Board of Directors. 
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Add a Display! 
By Dorothy Fitch, Editor, Green Valley Resort Computer Club, AZ 

February 2019 issue, Green Bytes, www.ccgvaz.org 

Newsletter (at) ccgvaz.org 

 
 
 
 
 
 
 
 
 
 
 
 
 

Photo Credit: everystockphoto.com 

 

If you spend a lot of time at your computer, as I do, you might want to consider having two 

separate monitors. I love my two displays, as it gives me lots of extra digital "real estate" for 

when I have many windows open. I can use the mouse to drag windows from one monitor 

to the other. The second monitor can display the task bar and clock at the bottom, and 

you can even extend images across the two displays or show the same content on both 

monitors. 

 

On Windows 10, to set up or adjust multiple displays, go to Settings>System>Displays. One 

monitor will be your primary monitor, and the other the secondary one. You can have a 

different resolution setting for each monitor. You can also swap the positions of the icons in 

the Settings area so that when you want to drag a window to the other monitor, you don't 

have to drag your mouse the opposite way, which is quite counter-intuitive! Click to read 

about dual monitor setups. 

 

But what do you do when a monitor fails, as my second display did the other day while I 

was working on this Green Bytes newsletter? The contents of a file open on that monitor 

started to flicker and then I watched the monitor turn completely black. Oh, my.... There 

were a number of open windows and documents displayed on that monitor and now I 

couldn't get to them! What to do? Google to the rescue! 

 

By Googling this text -- see files when second monitor is off -- I found the answer! All I had to 

do was hold down the Shift key as I right-clicked the icon on the Taskbar for the document I 

couldn't see. I could choose the 'Move' option from the menu, and then use the right-arrow 

key on the keyboard to move the window, little by little. Lo and behold, it came into view 

on my one working monitor. 

 

If you have room on your desk and a second monitor available, you might enjoy having the 

extra room for all your work (and play). Got to Page 1 

file:///C:/Users/swalb/Documents/00TCPC/2019.April.PUSH/everystockphoto.com
https://ccgvaz.us16.list-manage.com/track/click?u=fc5b48c8cad5d194a77f4cb54&id=87a4190140&e=2857111c01
https://ccgvaz.us16.list-manage.com/track/click?u=fc5b48c8cad5d194a77f4cb54&id=87a4190140&e=2857111c01
http://bit.ly/2H03bFe
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A Great Photoshop Alternative  
By Sheila Swaikowski, Webmaster, The PCUG of Connecticut 

March issue, The Program, www.TPCUG-CT.org 

sswaikowski (at) yahoo.com 

Gimp is a great free image manipulation program much like Photoshop. Here is a YouTube 

link to a 13+ minute video of a basic beginners’ guide that I found very helpful: 

Q8C0LJPpr64.mp4. It is entitled ‘How to Use Gimp (A Beginners Guide)’ and produced by 

TechGumbo. According to the instructor, Gimp is one of the top five best free Photoshop 

alternatives and his favorite.  

 

The video begins by showing where to go (gimp.org) to download Gimp and walks you 

through the whole download process. Then it goes over the layout you should see when 

you start Gimp: the primary window in the center, the toolbox on the left and the layers 

window on the right.  

 

The instructor starts a new project by creating a new image from the file tab at the top. He 

shows how to scale it down (resize it) and add a background color.  

 

Gimp works with layers, which is a new concept for me. Changes are made on individual 

layers which become part of the whole exported image at the end. If a change has to be 

made, you can go back to that particular layer which has what you want to change. You 

create a new layer from the right layer window. The video shows how to create text in a 

new layer by going to the toolbox, selecting the text tool, then selecting a different text 

color and changing the text size. It shows how to use the move tool to move the text 

anywhere in that layer.  

 

If you don’t like what you produced, you can go back to a previous step or steps by going 

to the Edit tab at the top and choosing Undo Move Text Layer which will undo the last 

operation or using the shortcut, ctrl z, until you get back to the step you want.  

 

The instructor creates an oval in a new, second layer, by selecting an ellipse tool from the 

tool box; other options are the rectangle tool or circle tool. He also shows how to use the 

blend tool in the background to show a color variance in the background.  

 

In this video there are three levels: the background image, the layer with the text and the 

layer with the oval drawn on it.  

 

When you are done, its time to export the created image by going to the File tab and 

clicking on Export As and exporting the image in the file type you want, png or jpg being 

the most popular. Even though you work with each level separately in Gimp, they become 

one image upon exporting.  

 

If you choose the Save As option in the File tab and also save the image as an .xcf file type, 

you can retrieve and work on the image later and make changes in the different layers. It 
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seems to me to be a good idea to also save an .xcf file.  

 

So there you have it, a very good, basic beginners video introduction to Gimp. There are 

other You Tube videos you can find by searching for Gimp that will show you how to do 

specific things, such as rounding corners in a photo. If you’ve ever wanted to do photo 

editing, but hesitated because of the cost of Photoshop, this Gimp tutorial is just what you 

may need. 

President's Corner 

Build a Wall? 
By Greg Skalka, President, Under the Computer Hood UG, CA 

February 2019 issue, Drive Light www.uchug.org 

President (at) uchug.org 

Walls can keep things out. Walls can keep things in. Walls that do these well usually aren’t 

so good at also letting some things pass from one side to the other. 

 

Walls are meant to separate. You can’t have separate things without some kind of 

boundary or barrier between them. Countries have borders that define the extent of their 

territories. Parcels of land have survey markers that define their boundaries. Our dwellings 

have their spaces defined by their walls, doors, windows, floors and roofs. Our bodies have 

skin and tissues that define what is within us and what is external to us. 

 

Borders and boundaries can vary in permeability. Some need to be more porous, letting 

more things in or out. Others need to be more impenetrable, keeping most things out for 

protection or in for containment. In many cases a single barrier approach is not sufficient; a 

layered approach with many aspects to the boundary is more effective. 

 

Our body’s skin and hair help protect us, but they can’t be too impenetrable, for without 

the ability to ingest food, expel wastes and exchange gases with the external world, we 

would quickly die. Our bodies must have a layered defense, with our immune systems 

helping to fight off infections that get past that initial outer boundary. We can also use 

technology to help, with clothing and sunscreen adding protection against solar radiation, 

for example. Our homes must follow similar border compromises, for while living behind 

blast doors in Cheyenne Mountain might provide great safety, we would lose easy contact 

with the outside world. Our home’s windows let in desirable sunlight, but we must often 

draw the curtains to protect our privacy. Walls, while often essential, are seldom a one size 

fits all solution to boundary problems. 

 

Our modern tech communication systems have given us the ability to easily exchange 

information instantly and at low cost with anyone on the planet. Unfortunately, we must 

erect barriers in these mediums to protect ourselves from offensive information and 

interactions, while still allowing us to send and receive the information we want. Just as in 

Go to Page 1 
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the physical world we might like to build a wall to keep away someone that has violated 

our “personal space” and tries to talk to us from six inches away, we need walls in our 

electronic interactions to protect us. 

 

Our oldest form of electronic communications that is still in common use is the telephone; it 

has been around since the late 1800’s. In the early days, the cost to use it provided a barrier 

to misuse. While the recent modernization of the system and its lower costs have benefited 

the user greatly, undesirable use has also greatly increased as a result. In addition to scam 

calls, legitimate businesses often overuse the system as it has become a cheap way to 

advertise and to solicit customers. Today most of the calls I receive on my home phone and 

my cell phone are unwanted. While I do receive some useful calls, such as medical 

appointment reminders and notifications that my prescriptions are ready to pick up, most 

are calls to try to sell me solar panels, get me to refinance my home mortgage or solicit 

donations. Some are of criminal intent, trying to impersonate the IRS or some other entity, 

with hopes of convincing me to send them money. I’ve had to add technology and alter 

my behavior to try to wall these people out of my life. 

 

For my home phone, an answering machine is an essential barrier in the communications 

chain. I don’t have Caller ID, so unless I happen to be expecting an immediate call, I make 

it a practice never to answer when it rings. I allow all calls to go to the answering machine, 

which I use as a filter. Unless the calling party’s message is compelling enough, I will simply 

delete the message. I think most scammers and many businesses are deterred by the 

answering machine barrier, as most calls I receive result in no message left. This wall seems 

to be working well, at least so far. 

 

I also get unwanted calls on my smart phone, but here I have more layers of tech barriers to 

help. It has Caller ID, but the scammers can falsify the information transmitted about their 

identities, reducing its usefulness. My phone carrier is T-Mobile, which sometimes helps by 

identifying calling numbers as “Scam Likely.” 

 

I have done some phone programming to help me quickly identify those unknown callers 

trying to scale my tech walls. I have only added numbers to my phone’s contact list that I 

truly wish to receive calls from. For each contact added, I have changed the ringtone for 

that contact to something other than the default for the phone. When my phone rings and I 

can’t see the display (if it happens to be on the other side of the room), I can still tell that 

the caller is in my contact list, as it will ring with a ringtone that is different from the default. If 

it is the default ring, I know it is not one of my contacts and I don’t need to get up to 

answer, as I’ll just let it go to voice mail. Again, my border defense is multi-layered, with 

technology and my behavior helping to filter out the bad guys, while allowing me to easily 

communicate with those I like. 

 

My smart phone also allows me to send and receive text messages, but I’ve yet to receive 
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any unwanted texts. If I do, I’ll have to come up with some kind of tech barrier to counter 

those intrusions. 

 

There was once a time when receiving a letter in the mail was a cause for excitement; now 

we mostly receive junk mail and bills. Of the roughly 40 years we have had email, the early 

years had that excitement. Unfortunately, as costs came down and connections 

proliferated over the globe, email communications became primarily electronic junk mail 

and scams. I keep trying to find ways to make email great again, but it has proved to be a 

daunting task. I can’t seem to find the right kinds of walls and barriers, as it is much harder 

to separate the desired from the undesirable in this medium. 

 

One of the problems with barriers for email is that they are often swamped by quantity. I 

typically receive 50 to100 emails to my primary personal account per day. I might get a few 

of personal correspondence, maybe some financial alerts and notifications, a bunch of 

advertising that I am interested in, a bunch of legitimate ads that I’m not, some scammy 

stuff and a few really odd ones. Most of my email appears to be safe. I have had phishing 

emails from time to time - emails from banks I don’t do business with (and a few that I do) 

asking me to click on a link. I’ve also received a few emails with suspicious attachments - 

who knows what malware they may contain. 

 

Some email users swear by spam or junk filters. Some email providers have filtering 

capability, and there are also external spam filters that can be used. My provider does not 

provide filtering, my client (Thunderbird) appears to have some junk filtering but I’ve never 

tried it, and I’m not desperate enough so far to try external filters. I am skeptical of the 

effectiveness of email filtering programs. They may be able to filter off the very bad items, 

but I can usually spot those fairly easily anyway. My bigger concern is for items that I only 

want to see periodically, or that I have to investigate to see if I want. Sometimes I want to 

see the Fry’s or Groupon emails, and sometimes I don’t. I’m still looking for walls that work for 

my email needs; right now my walls are pretty low, and I do a fair amount of manual 

inspecting on what comes over.  

 

The Internet is only about 35 years old and already has over half the people in the world 

using it. It and the World Wide Web allow people anywhere on the planet (and even in 

space, on the International Space Station) to get information and communicate with any 

of the other users. With this borderless medium, each user requires some boundaries be 

placed at the interface to their network for protection. An Ethernet router is the main line of 

defense, a wall between your network and the rest of the Internet. Making sure your router 

is configured correctly for maximum security will help block malicious intrusions into your 

network and computers, while allowing you to get the information you need. Setting up 

your Wi-Fi correctly is also an essential part of keeping your network safe and preventing the 

misuse of your internet connection. 
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In our electronic, interconnected world, boundaries are essential for keeping our 

communications secure and our personal data private, but just putting a wall around 

ourselves is not the answer. The barriers we use must be appropriate and configured for 

maximum protection with minimum restriction for the passage of desired data. A layered 

and evolving defense will usually be the most practical and have the most success.  

 

CES 2019 
By George Harding 

Tucson Computer Society 

January 21, 2019  

There were 180,000 attendees, 4500 vendors and some 500 qualified press. 

 

Press events: Unveiled (150 vendors), Digital Experience (250 vendors), ShowStoppers (200 

vendors), press conferences all day Monday. 

 

Notable items: More IoT and AI, plus 5G, 4K and OLED, autonomous cars, VR and AR 

(VR means "Virtual Reality". AR means "Augmented Reality.) 

The Internet of Things (IoT) is several years old now and has been used to allow operation of 

one or more devices remotely with one controller, usually a smartphone. Ex., lights, 

thermostat, garage door, etc. 

 

Now IoT has been widely expanded to allow remote control of all devices with one 

controller. The goal appears to be to hook everything to everything else. 

 

Artificial Intelligence (AI) is the use of computer programs to decide to take specific 

actions when defined circumstances occur, i.e. to cause apparently intelligent actions 

One device that is a combination of AI and IoT is Footloose, a cat waste disposal device. 

But it’s more than that. It also analyzes the waste to identify possible illness, dispose of the 

waste hygienically, checks cat’s weight how often it uses the device, how long it spends 

there and how much it leaves behind. It can identify multiple cats (if you have more than 

one). It’s also self-cleaning and odorless, using NASA technology. There’s also a 

smartphone app. 

 
 

Go to Page 1 
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Another example is a food-ordering system, perhaps set up in a public place, like an 

apartment lobby. You select your choices and the food is delivered into your cubicle. 

Again, a smartphone app is part of the system. 

 
AI has tremendous potential and has already been used by many companies to speed up 

business operations.  

 

The 60 Minutes program last Sunday talked with a Chinese entrepreneur investing in AI 

startups. They have 140 of them so far, 10 being worth $1 billion already. He says 

“Intelligence” is a misnomer, since these programs cannot think like a human and will never 

be able to do what humans can do. 

 

5G is the latest generation of cellular mobile communications. It brings higher data rates, 

lower latency, higher system capacity and massive device connectivity (per Wikipedia). It is 

expected to allow much faster cellphone service, and much broader coverage. AT&T, 

Sprint and Verizon have already demonstrated 5G in limited locations. General availability 

is expected in 2020. 

 

TV innovation is slowing, leading to ubiquitous inclusion of 4K and OLED. There is 8K on the 

horizon, but little is the way of source material. 

 

Organic Light Emitting Diode (OLED) is created with a film of organic compound that emits 

light in response to electric current. This technology provides excellent color response, 

referred to as HDR, with blacker blacks and whiter whites. It also provides a much thinner TV 

unit, typically 3/4ths of an inch thick. 

 

As usual, there were many car makers with their concept models. Autonomy is getting 

more widespread and the devices are being incorporated into the design, rather than 

strapped on top and side.  
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There was an autonomous VTOL helicopter from Bell.  

 

 

Hyundai Elevate helps first responders access very difficult areas.  

 
See video at https://youtu.be/A33Yu-9rgxo 

 

Drones continue to increase in ability and decrease in price. DJI is the leader in the industry 

currently. Their lowest price drones are Mavic and Spark 

https://youtu.be/A33Yu-9rgxo
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The rotors of the Mavic fold inward, making a very compact device to carry. 

 

The increased speed of computer chips and the sophistication of devices has made 

VR more widespread, being used in companies for training, repair and more. AR is still 

not widespread. 

 

Kodak showed a very small, compact projector, Luma, which can project to an 8-foot 

screen. 

 
 

All in all, CES is a mammoth event that shows what is being provided today and will be 

provided tomorrow by companies that serve the consumer market. 
 

CES is presented in early January each year. See their web site at www.ces.tech  

Dan’s Desk 

Encrypting a Drive 
By Dan Douglas, President Space Coast PCUG, FL 

March 2019 issue, The Space Coast PC Journal, www.scpcug.com 

datadan (at) msn.com 

Last month I described a BIOS password problem that I had to solve. This month, we’ll 

look at other password locks such as those used for protecting hard drive data. 

 

One of the added features of Windows 10 Pro over the Home edition capabilities, is 

the ability to encrypt a drive to protect all data and files contained on that drive from 

Go to Page 1 

http://www.ces.tech
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unauthorized access. An administrator can select a drive from the File Explorer app 

and turn on the BitLocker option from the right mouse button option list. The user must 

then select an encryption key using any combination of uppercase and lowercase 

letters, numbers or symbols up to 64 characters long. It is critical to record this 

password as it will be impossible to access the files afterwards without this key. 

Windows will prompt you to save this key on your cloud account, or in a file or by 

printing it before encrypting the drive.  

 

I recently had a customer who had a broken Surface PC and needed to recover 

some business files from the drive. The first place they’d taken it to had told them that 

it was not possible to access the data, not because it was encrypted, but because 

the drive was a solid-state circuit board, as is usually found in tablets and many Macs, 

and did not have the usual SATA drive connector. Having used many drives of this 

type before, I had the correct adapter to convert it to a SATA type connector. That 

was when we discovered that it had been locked using BitLocker. It prompted us to 

enter the key and the owner had no idea what that key may be. I told them that 

without the key I could not access the data for them. They were advised to check all 

of their paperwork to see if it was recorded somewhere. Fortunately, when the PC was 

purchased, the BitLocker key was written on their bill of sale by BestBuy! When they 

returned later with the key, we were able to access the data and transfer the files to a 

USB stick.  

 

If you need to encrypt just specific files or folders and not a complete drive, there are 

several alternatives available. For example, Word and Excel provides for the ability to 

protect a document by applying the ‘protect document’ option to the file through 

the Word or Excel options. Adobe Acrobat can also be used to protect PDF type files. 

In certain versions of Windows, namely Windows 10 Pro, Windows 7 Professional, 

Windows 7 Ultimate, Windows 7 Enterprise, Windows 8 Pro or Windows 8 Enterprise also 

come with an Encrypting File System (EFS), which lets you encrypt any kind of file, as 

well as whole folders and subfolders. Users with a Home edition of Windows will need 

to use either the Office Suite encryption or a third-party solution, such as TrueCrypt, 

VeraCrypt or 7-Zip. EFS is applied by selecting the folder or file, select the properties/

advanced through a right button click, and then select the ‘encrypt contents to 

secure data’ option. This encryption is applied using the logon ID and password so it is 

not as secure as that used by the BitLocker and I’m not sure what would happen if the 

password used by that ID was removed using a password removal tool. Possibly the 

data would stay encrypted and still require the original password to allow the files/

directories to be accessed.  

 

Many USB drives also offer their own encryption system for the files on that drive, but I 

would be hesitant to use these as the proprietary nature of the program may cause 

problems later.  

Go to Page 1 



May 2019  The Digital VIKING 13 

Special Interest Groups (SIGs) 
 
Most SIGs will meet at Edina Executive Plaza, Conference Room #102, 5200 
Willson Road, Edina, MN 
 Confirm with a SIG group if they meet elsewhere. 
For more info contact the SIG Leader(s) listed here. 

 w Work phone    h Home phone   c Cell phone 
 * Meets at an alternate location 

Get SIG announcements! 
Link from www.tcpc.com 

Directions to Edina Executive Plaza 
for Systems on Saturday, Access,  
Word and Picture Perfect SIGs: Take 
Highway 100 to the 50th Street/Vernon 
exit. [If you have come from the north, 
cross back over Highway 100 to the 
east side.] Take the first right and go 
past Perkins [The golf course will be on 
your left.] and continue on the east 
frontage road (Willson Road) to the 
next building—5200 . There is ample 
parking in the building’s lot. 
Conference Room #102 is on 1st floor. 

Directions to Summit Place for General Meetings: 
Proceed to Eden Prairie Center Flying Cloud Drive . [Flying Cloud Drive runs along 
the West side of the Eden Prairie Center.]  Once you have driven past Eden Prairie 
Center (on the left) along Flying Cloud Drive you will come to a stop light at Prairie 
Center Drive.  The next intersection with a stop light and left turn lane is Fountain 
Place. Turn left at Fountain Place and go straight into the parking lot. Turn left again 
to the first covered entry way of Summit Place.  There is plenty of parking in the 
large parking lot in front of the first Summit Place covered entry way.  When you 
enter the door at the first covered entry way, ask to be directed to the Performance 
Room for the TC/PC meeting.  For a map of more detailed directions and info on 
Web SIG and Board meeting, check the TC/PC website. 

Help yourself by helping others! 

Join the team & share your knowledge with others. 
Contact TC/PC at www.tcpc.com 

Board of Directors* 
All members are welcome! Check 
www.tcpc.com for location. 
Selected Saturday mornings 
 

Linux on Saturday 
This is for the Linux newbie and those trying 
to come over from Microsoft to a different 
operating system. 
Second Saturday @ 9 AM-Noon 
Note: No Meetings June-August 
 
Jack Ungerleider 612/418-3494 c 
 jack@jacku.com 

 
Tech Topics 
Technical presentation/discussion on 
various technical topics from the following 
areas:  
•         Web/Internet  
•         Mobile Devices and Apps  
•         Playing with Programming  
•         DIY (3D Printing, R-Pi, other hobby 
electronics, etc.) 

 

Second Tuesday @ 6:00-7:00 PM 
Every  month 
Right before the general meeting. 
 
Jack Ungerleider 612/418-3494 c 
 jack@jacku.com 

Microsoft Access 
All levels. Presentations by expert develop-
ers within the group and by MS reps. 
Third Saturday 9:00 AM—Noon 
Note: No Meetings June-August 
 
Steve Kuhlmey 952/934-8492 
 skuhlmey@hotmail.com 
 

Microsoft Office 
Addresses the use, integration, and nuanc-
es of the Microsoft Office applications. 
Combined with Systems on Saturday 
Third Saturday of the Month  
9:00 AM—Noon 
Note: No Meetings June-August 
 
 
Steve Kuhlmey 952/934-8492 
 skuhlmey@hotmail.com 
 
 

http://www.tcpc.com
http://www.tcpc.com
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5 6 7 8 9 10 11  
Linux on Sat-
urday 
9 AM—Noon 
 

12 13 14 General Meet-
ing 
Combining Pho-
tos 
 
6PM Tech Topics 

15 16 17 18  
MS Office 
(including 
Access) 
9 AM—Noon 
 

19 20 21 22 23 24 25 
 

26 27 28 29 30 31 1 
 

2 3 4 5 6 7 8 
Linux on Sat-
urday 
9 AM—Noon 
 

9 10 11 
General Meeting 
Annual Meeting & 
Pizza 
 
6PM Tech Topics 

12 13 14 15 
MS Office 
(including 
Access) 
9 AM—Noon 
 

16 17 18 19 20 21 22 
 

23 24 25 26 27 28 29 
 

30 31      
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You have just read an issue of The Digital Viking. 

 
Would you like to receive this delivered directly to your email or business each month? 

 
As a member of TC/PC, the Twin Cities Personal Computer Group, one of the benefits 

 is reading this monthly publication at www.tcpc.com.. 
 

As a member of TC/PC, you may attend any or all of the monthly Special Interest Group (SIG) meetings and be eligible for 
software drawings. The small membership fee also includes  

access to real-live people with answers via our helplines, discounts, and various other perks. 
 

Does membership in this group sound like a good way to increase your computer knowledge? 
 

It’s easy to do! Simply fill in the form below and mail it to the address shown. 
(If you use the form in this issue, you will receive an extra month for joining now.) 

 

 
Here’s the info for my TC/PC Membership: 
 

Full name_____________________________________________________ 

 

Company name________________________________________________ 

 

Address______________________________________________________ 

 

City_______________________________ State_________ Zip__________ 

 

Home  Business  Change address: Perm. Temp. ‘til ___________ 

 

Home phone____________________  Work phone____________________ 

 

Online address(es) _____________________________________________ 

 

Where did you hear about TC/PC? _________________________________ 
 
 I DO NOT want any of my information disclosed. 

 I DO NOT want to receive any mailings 

 
Administrative Use Only     Rec’d_____________________  Chk#_______________ 

 5/19 
I’m signing up for: 
 

 Individual/Family Membership ($18) 

 Business Membership ($100) 

If an existing member your # __________ 

Make checks payable to: 

Twin Cities PC User Group 
341 County Rd C2 W 
Roseville, MN 55113 
 

http://www.tcpc.com 
 

 Check #__________  Bill me 

 New member  Renewal  Prior member 

I’m interested in: 

 Training classes  Volunteering 

 Special Interest Groups: New User, Access, 
etc. 

List here: 
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FIRST CLASS MAIL 341 County Rd C2 W 
Roseville, MN 55113 

November 8, 2011 • 7 PM 

General Meeting 
 

The Microsoft Store 
 

The Microsoft Store 
162 South Avenue 

Mall of America 

More info: www.tcpc.com 

May 14, 2019 
General Meeting 7:00 PM 

 

CES 2019 
Virtual Tours 

 
 

Summit Place 
8505 Flying Cloud Dr. 

Eden Prairie, MN 55344 
 

More info and map: www.tcpc.com 
P 

Hwy 494 

Eden Prairie 
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Prairie Center Drive 
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